Using More Than One Table

Often times a database will have more than one table. For example, in a customer database, one table might contain information about each individual customer and another table might hold information about which items they ordered.

In order for the user to query information found in multiple tables, a relationship between the tables must be defined.

Understanding the Types of Relationships in an Access Database

One-To-Many Relationship
One record in a table is related to many records in another table. An example would be that one customer can place many orders.

A Many-to-Many Relationship
A good example of this would be between a Products table and an Orders table. A single order can include more than one product. On the other hand, a single product can appear on many orders.

A One-to-One Relationship
Each record in the first table can have only one matching record in the second table, and each record in the second table can have only one matching record in the first table.

Relationships Between Tables

To Create a Relationship Between Tables:
1) Click the Database Tools tab
2) Select Relationships

To Define the Relationships between the Tables in your Database:
1) Double-click on the tables in the Show Tables window to add them to the Relationships window
2) Close the Show Table window
3) Left click and hold the mouse button down on the field that you want to relate to a field in another table.
4) Drag your mouse from one field in one table to another field in another table.
Parent/Child Table Relationships

This is best understood by examining the relationships defined in the example displayed below:

In the **Courses** table the Course ID field is the Primary Key field. For each record in Courses, there are many related records in the **Attendance** table. In this example, the Courses table is considered the **Parent Table** and the Attendance table is considered the **Child Table**.

**Referential Integrity**

Enforcing referential integrity ensures that the following three rules will not be broken:

- You are unable to enter a value in the foreign key field of a child table if that value doesn't exist in the primary key of the parent table.
- You are unable to delete a record from a parent table if matching records exist in a related table.
- You are not able to change the value in the Primary Key field if that record has related records in another table.

**To Enforce Referential Integrity:**

1) Click the **Enforce Referential Integrity** check box
2) Click **Create**
The relationships window will show a line between the related fields as shown below:

![Relationships Diagram]

On one end of the line is a “1” indicating the “one” side of a one-to-many relationship.

The other end of the line will have an infinity symbol next to it to show that there are potentially many entries on the “many” side of the one-to-many relationship.

**Cascade Update Related Fields**
If this item is selected, the following rule applies:

Access will automatically update any foreign key values in the “child” table (the “many” table in a one-to-many relationship) if you change a Primary Key value in a “parent” table (the “one” table in a one-to-many relationship).

**Cascade Delete Related Records:**
If this item is selected, the following rule applies:

Record(s) in the “child” table will be deleted when a related record(s) in the “parent” table are deleted.

**Creating Queries**

**Using AND Logic in a Query**

Using **AND** logic in a query will return records in which one condition is true AND another condition is also true. For example:

**To Find all Employees who Attended Access Training and Passed:**
1) Click the **Create** tab
2) Click **Query Design** in the **Queries** group
In order to add fields to the Query Grid, you must first add the tables that the fields are in.

**To Add Tables to the Grid:**
1) Double-click on the table names
2) Close the **Show Table** window once you have added all the necessary tables
3) Double-click to add a field to the query grid
4) In the criteria row, type the criteria

The criteria entered in the example below are as follows:

**Course ID field criteria: Access***
This will locate any course ID that begins with the word Access and ends in anything.

**Passed field criteria: Yes**
This will locate any records of individuals who have passed Access.

If both of these criteria exist on the same row of the query, it creates **AND** logic.

**To Run the Query:**
Click the **Run** icon (red exclamation point) on the Ribbon
The results of this query are displayed below:

Saving a Query

When you save a query, what you are saving is really the question you are asking, not the results that you see when you run a query. For example, in the above query we asked to display any records where the course ID contains the word “Access” and the passed field is “Yes”. If we run that query next week, we are likely to see more records as a result.

To Save the Query:
1) Close the query
2) Click Yes to save the query
3) Enter a name for the query
4) Click OK
If you don’t see the query in the navigation bar you need to select **All Access Objects** in the navigation bar:

1) Click on the navigation bar drop down arrow  
2) Select **All Access Objects**

![All Access Objects screenshot]

**Creating OR Logic in a Query**

**OR** logic is based on the fact that either condition(s) can be true in order for a record to be included in the results of the query.

**To Create a Query Using OR Logic:**
1) Click the **Create** tab  
2) Click **Query Design** in the **Queries** group  
3) Double-click on the table names  
4) **Close** the Show Table window once you have added all the necessary tables  
5) Double-click to add the fields to the query grid  
6) In the criteria row, enter the criteria for the query. By placing criteria on two separate rows in the grid, OR logic is automatically created

Below is an example of OR logic in a query:
- **Course ID field criteria: Access***  
- **Course ID Field criteria: Excel***  
- **Passed field criteria: Yes**

This will locate any records of individuals who have attended Access or Excel and passed.
Below are the results of this query:

![Query Results Image]

### Using a Calculated Field in a Query

A query can be used to perform calculations. As an example, you can create a new field in a query that calculates the Hours Worked field multiplied by the Rate of Pay field. You are also easily able to add two fields together, or multiply one field by another field.

#### To Create a Calculated Field:
1. Click in the next empty field cell in the query grid
2. Press **Shift F2**
3. Type the name of the new field in the dialogue box followed by a colon and then a space and then the formula
4. **For Example HourlyRate: [cost]/[hours]**
5. Click **OK** when finished. This creates a new field in the query called *HourlyRate*.

#### To Format the Field to Currency:
1. Right-click on the calculated field you created
2. Select **Properties**
3. Click in the **Format** line and click on the drop down arrow
4. Select **Currency**
5. Close the Property Sheet
6. **Run** the query
Creating a Summary Query
To summarize records in a table, use the **Group By** and **Sum** function in a query.

**To Summarize a Field in a Query:**

1) Click the **Totals** icon on the Ribbon
2) Notice the total row has now been inserted into the query grid
3) Select **Group by** for the Location field to group the locations together
4) Select the **SUM** function for the Cost field to sum the cost per location
5) Click the **Run Query** icon

Below are the results based on the criteria above:
Including Operators in a Query

You are able to create criteria based on the following operators:

- < Less Than
- > Greater Than
- <= Less Than or Equal To
- >= Greater Than or Equal To
- = Equal To
- <> Not Equal To

You are also able to define criteria based on a range.

To Locate Specific Records Within a Range of Dates:
1) Add the necessary fields to the query grid
2) After adding the fields to the query grid, position your cursor in the criteria row for the field you are defining
3) Enter the criteria

In the example below, the criteria is to identify records where the registration date is between February 1, 2006 and February 28, 2006.

Creating and Using a Parameter Query

In a Parameter Query the criterion written on the criteria line is actually a prompt to the user of the query to type in a criterion. The prompt must be enclosed in square brackets (located above and to the left of the ENTER key) on the criteria line. When executed, the query will display a prompt, and the user will enter the criterion he or she wishes to use. When the Parameter Query is run, the prompt written on the criteria line will display as shown below.

To Create a Parameter Query:
1) Position your cursor in the criteria row for the field for which you would like to create the parameter
2) Type [enter text to be displayed]. For example, to see results based on a course ID type [Enter course ID]
3) Press Enter when finished
4) Click the Run Query icon
Below is an example of a Parameter Query that prompts the user to enter a Course ID:

Forms

Forms are used to either view records that are in a table, or used as a way to enter records into a table.

To Create a Form:
1) Select the table from the navigation pane that the form will be based on
2) Click the Create Tab
3) Click on Form

The form is created and puts you in Layout View.

There are 3 basic views in an Access form:

Layout View
The form is actually “live” in this view, so you can see your data as it will appear in Form view. However, you can also make changes to the form design in this view. Because you can see the data while you are modifying the form, this is a very useful view for setting the size of controls or performing almost any other task that affects the appearance and usability of the form.

Design View
This view gives you a more detailed view of the structure of your form. You can see the header, detail, and footer sections for the form. The form is not actually running when it is shown in Design view, so you cannot see the underlying data while you are making design changes; however, there are certain tasks you can perform more easily in Design view than in Layout view. In this view you can add controls to your form, edit control sources and resize form sections.

Form View
This view is used to enter, edit or display data in your table.
There are 3 main sections of an Access form:

In Design View, there are sections for the **Header**, **Detail** and **Footer**. If data is in the form **Header**, the data will display/print at the top of the form only. Data in the **Detail** section is records from the table or query that the form is based on. If there is data in the **Footer** section, the data will display/print at the bottom of the form.

Understanding Controls on a Form

Forms are made up of 3 things: **Bound Controls**, **Unbound Controls** and **Calculated Controls**. A **Bound Control** is a control whose source is connected to a field or query. An **Unbound Control** is a control that is not connected to a source such as a field in a table or query. An example of this type of control is a title on a form, a picture, line or other label. A **Calculated Control** is a control whose source is a formula or expression.

To Edit a Control on a Form:
On a form, there are two types of commonly added controls: a **label control** and **text box control**. A **label control** will allow you to simply add text to a form. A **text box control** will allow you to add a field from a table/query.

To Add a Label Control to a Form:
1) Switch to **Design View** if necessary
2) Click the **Label** Icon
3) Click your mouse where you would like to add the text
4) Type the text
To Add a Text Control to a Form:
1) Switch to **Design View** if necessary
2) Click on the **Text Box** icon on the toolbar
3) Click on the form where you would like the control to exist

Below is a picture of a text box control that has been added to a form:

Text18 is the label for the control. **Unbound** means that there is no connection between a field in a table/query and this control.

To Associate this Control with a Field in a Table/Query:
1) Right-click where it says **Unbound**
2) Select **Properties**
3) In the **Control Source** row select the field with which you would like to associate the control
4) Close the Property Sheet Window

To Edit the Label to the Left of the Control Just Added:
1) Double-click on the **Label Control**
2) Type text

To Move a Control:
1) Select the **Arrange** tab on the Ribbon
2) Click **Remove Layout** from the **Table** group
3) Click on the control you wish to move
4) Click and drag the control to a new location on the form
To Change the Tab Order on a Form:
1) Right-click on the form
2) Choose **Tab Order**
3) Click to the left of the field
4) Click and drag the control to a new position in the **Tab Order** window

![Tab Order Window](image)

To Add a Calculated Control to a Form:
1) Switch to **Design View** if necessary
2) Click on the **Design** tab under **Form Design Tools**
3) Click on the **Text Box Control** icon
4) Click on the location on the form where you want to add the new control
5) Right-click where it states unbound
6) Choose **Properties**
7) On the **Data** tab, click to position your cursor in the Control Source field
8) Enter a formula. For example; =Sum([cost])
9) Close the Property Sheet Window

![Form Design Tools](image)
Reports

In order to capture that data that you would like to report on, you must first create a query to identify the records to be included in the report. After you have created the query, you need to think about the design and layout of the report.

**To Create a Report Based on a Query:**
1) Open the query that the report will be based on
2) Click the **Create** tab on the Ribbon
3) Click **Report**
4) A report will be created for that query/table and opens in **Layout View**

Reports are similar to forms in that they are made up of sections and controls. To change, move controls or add additional controls, switch to **Design View**.